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	CEW-01 (ส่วนที่ 1) : Microsoft Word 


วัตถุประสงค์  เรียนรู้การใช้งานพื้นฐานโปรแกรมการจัดการงานเอกสาร เช่น Microsoft Word

กล่าวนำ
Microsoft Word เป็นโปรแกรมประมวลผลคำ  (Word Processing Application ) ที่สามารถทำงานได้ทั้งภาษาไทย ภาษาอังกฤษ และภาษาอื่นๆ สามารถติดตั้งได้บนระบบปฏิบัติการ Windows XP/2000 โปรแกรมมีความสามารถในการใช้ทำงานด้านเอกสาร เช่น จดหมาย รายงาน บันทึกข้อความ ใบประกาศ และคู่มือการใช้งานต่างๆ  การจัดการกับข้อความในเอกสารได้อย่างง่าย เช่น การแก้ไขข้อความ ตกแต่งด้วยสี และแบบตัวอักษร การใส่ตาราง รูปภาพ การตรวจสอบตัวสะกดและไวยากรณ์ การทำจดหมายเวียน และการใช้งานเอกสารร่วมกัน นอกจากนี้ยังสามารถบันทึกเอกสารในรูปแบบของ XML เพื่อให้ผู้ใช้สามารถแยกเนื้อหาของเอกสารออกจากขอบเขตของรูปแบบของเอกสาร
การใช้งาน  Microsoft Word

1. การเข้าสู่ Microsoft Word

วิธีที่ 1 : เปิดเมนู Start -> คลิก Programs -> คลิก Microsoft Office -> คลิก Microsoft Word 2003
วิธีที่ 2 : ดับเบิ้ลคลิกที่ icon ของ Microsoft Word 2003 บน desktop (ถ้ามี)
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รูปที่ 1 หน้าจอการทำงานของ Microsoft Word

1.1 การใช้ทาสก์เพน (Task Pane) 
ทาสก์เพน หรือบานหน้าต่างงาน คือส่วนประกอบใหม่ของ Office 2003 ที่ช่วยการทำงานบางอย่างให้ง่ายขึ้น ซึ่งปกติจะมีทาสก์เพนที่ทุกโปรแกรมใน Office 2003 จะมีการเปิดทาสก์เพนให้ใช้โดยอัตโนมัติ ที่เหมือนกันคือ 

• Getting Started (เริ่มต้น) เริ่มต้นทำงานกับโปรแกรม เช่น สร้างเอกสารใหม่ หรือเปิดเอกสารที่เคยใช้งานไปล่าสุด 

• Help (วิธีใช้) ค้นหาความช่วยเหลือ, ฝึกอบรมออนไลน์ หรือดาวน์โหลด 

• Clip Art (แทรกภาพตัดปะ) ใช้ใส่รูปภาพ เสียง ภาพเคลื่อนไหวเข้าไปในไฟล์งานของคุณ โดยสามารถหาภาพตัดปะจากคำสำคัญหรือคีย์เวิร์ดของภาพตัดปะนั้น ๆ 

• Research (การวิจัย) ค้นคำเหมือนหรือคำที่มีความหมายเดียวกัน 

• Clipboard (คลิปบอร์ด) ใช้เก็บข้อมูลจากการ Cut หรือ Copy ได้ถึง 24 ชุด ไว้ให้เลือกวางหรือ Paste ได้ตามต้องการ 

• New Document (เอกสารใหม่) สำหรับสร้างไฟล์เอกสารใหม่ใน Word เปิดไฟล์เก่า แสดงไฟล์ที่เปิดใช้ล่าสุด หรือสร้างไฟล์ใหม่จากต้นแบบ (template)
1.2 แนะนำแถบเครื่องมือต่าง ๆ 
แถบเครื่องมือจะเป็นที่อยู่ของปุ่มที่ทำคำสั่งต่าง ๆ ซึ่งเหมือนกับการเรียกคำสั่งที่แถบเมนู ปุ่มเหล่านี้จะถูกแยกเป็นหมวดหมู่ไว้บนแถบเครื่องมือเป็นชุด ๆ มีหลายชุดด้วยกัน แต่ที่แสดงมีเพียง 2 ชุด คือ แถบเครื่องมือมาตรฐาน และ Formatting (จัดรูปแบบ) 
แถบเครื่องมือมาตรฐาน (Tool Bar Standard)
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รูปที่ 2 รูปแถบเครื่องมือ
1.3 การเพิ่มแถบเครื่องมือ

การเพิ่มแถบเครื่องมือทำได้โดยการคลิกขวาตรงที่ว่างข้างๆ แถบเครื่องมือดังรูปจากนั้นเลือกเมนูย่อย Customize แล้วเลือกแท็บ Command จากนั้นก็เลือกเครื่องมือที่ต้องในกลุ่มต่างๆ แล้วกดคลิกแช่แถบเครื่องมือที่เราเลือกแล้วก็ลากมาวางแทรกในแถบเครื่องมือใด้เลย
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รูปที่ 3 การเพิ่มแถบเครื่องมือ
แถบเครื่องมือที่ประกอบด้วยปุ่มที่มักจะใช้บ่อย ๆ มีรายละเอียด ดังนี้
	ปุ่ม
	ชื่อปุ่มและหน้าที่

	[image: image4.emf]
	New (สร้าง) เปิดเอกสารชุดใหม่

	[image: image5.emf]
	Open (เปิด) เรียกเอกสารชุดเก่าที่เก็บบันทึกไว้มาใช้ 

	[image: image6.emf]
	Save (บันทึก) สั่งเก็บบันทึกเอกสาร 

	[image: image7.emf]
	Permission (สิทธิ) การจัดการสิทธิ์ในการใช้ข้อมูล 

	[image: image8.emf]
	E-mail (as Attachment) (อีเมล์(ตามใบแนบ)) เปิดโปรแกรมสร้างอีเมล์ พร้อมแนบไฟล์ของ Word ไปด้วย

	[image: image9.emf]
	Print (พิมพ์) สั่งพิมพ์เอกสารลงบนกระดาษ 

	[image: image10.emf]
	Print Preview (ตัวอย่างก่อนพิมพ์) แสดงผลการพิมพ์บนหน้าจอเพื่อดูก่อนพิมพ์จริง 

	[image: image11.emf]
	Spelling (การสะกด) ตรวจสอบการสะกดคำตามพจนานุกรม 

	[image: image12.emf]
	Research (การวิจัย) ให้ข้อมูลอ้างอิงสำหรับงานวิจัย 

	[image: image13.emf]
	Cut (ตัด) ลบข้อความหรือออบเจ็คที่เลือกไว้ไปไว้ในคลิปบอร์ด 

	[image: image14.emf]
	Copy (คัดลอก) คัดลอกข้อความหรือออบเจ็คที่เลือกไว้ไปไว้ในคลิปบอร์ด 

	[image: image15.emf]
	Past (วาง) นำข้อความหรือออบเจ็คในคลิปบอร์ดมาวางในเอกสารตรงที่ต้องการ 

	[image: image16.emf]
	Format Painter (ตัวคัดวางรูปแบบ) คัดลอกรูปแบบข้อความหนึ่งไปใส่ให้กับอีกข้อความ 

	[image: image17.emf]
	Undo (เลิกทำ) ยอกเลิกคำสั่งหรือการทำงานที่ทำล่าสุด 

	[image: image18.emf]
	Redo (ทำอีกครั้ง) เรียกทำคำสั่งหรือการทำงานที่ถูกยกเลิกไป 

	[image: image19.emf]
	Hyperlink (การเชื่อมโยงหลายมิติ) สร้างการเชื่อมโยงจากตำแหน่งที่กำหนดไว้ไปยังเอกสาร หรือไปยังส่วนอื่นในเอกสารเดียวกัน หรือ URL 

	[image: image20.emf]
	Table & Border (ตารางและเส้นขอบ) แสดง/ไม่แสดงแถบเครื่องมือตารางและเส้นขอบ 

	[image: image21.emf]
	Insert Table (แทรกตาราง) ใส่ตารางในเอกสาร 

	[image: image22.emf]
	Insert Microsoft Excel Worksheet (แทรกแผ่นงาน) แทรกสเปรดชีทของโปรแกรม Microsoft Excel

	[image: image23.emf]
	Columns (คอลัมน์) จัดข้อความเป็นหลายคอลัมน์เหมือนหนังสือพิมพ์ 

	[image: image24.emf]
	Drawing (รูปวาด) เปิด/ปิดแถบเครื่องมือรูปวาด 

	[image: image25.emf]
	Document Map (แมปเอกสาร) เปิด/ปิดแผนที่เอกสาร 

	[image: image26.emf]
	Show/Hide (ซ่อน/แสดง) ซ่อนหรือแสดงสัญลักษณ์พิเศษ ซึ่งจะไม่ถูกพิมพ์ออกมา 

	[image: image27.emf]
	Zoom (ย่อย/ขยาย) ย่อหรือขยายเอกสารที่แสดงบนหน้าจอตามเปอร์เซ็นต์ที่เลือก 

	[image: image28.emf]
	Office Assistant (วิธีใช้ Microsoft Word) แสดง Office Assistant ซึ่งเป็นตัวการ์ตูนที่ให้คำแนะนำในการใช้งาน 


	[image: image29.emf]
	Read (มุมมองเค้าโครงการอ่าน) เปลี่ยนเค้าโครงของหน้ากระดาษ และปรับปรุงการแสดงผลของตัวอักษรเพื่อทำให้ผ่านข้อมูลได้สะดวกขึ้น เหมาะกับหน้ากระดาษ ที่มีข้อความยาว ๆ แต่จะไม่เหมาะกับพวกกราฟิก หรือตาราง

	[image: image30.emf]
	Styles and Format (ลักษณะและรูปแบบ) เปิดทาสก์เพน (Styles and Formatting)
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	Style (ลักษณะ) แสดงหรือใช้เลือก Style (รูปแบบ) ของข้อความตรงที่เคอร์เซอร์อยู่

	[image: image32.emf]
	Font (แบบอักษร) แสดงหรือเลือกแบบของตัวอักษรตรงที่เคอร์เซอร์อยู่
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	Font Size (ขนาดแบบอักษร) แสดงหรือใช้เลือกขนาดของตัวอักษรที่เคอร์เซอร์อยู่

	[image: image34.emf]
	Bold (ตัวหนา) ทำเป็นตัวหนาหรือยกเลิก

	[image: image35.emf]
	Italic (ตัวเอียง) ทำเป็นตัวเอียงหรือยกเลิก

	[image: image36.emf]
	Underline (ขีดเส้นใต้) ขีดเส้นใต้หรือยกเลิก

	[image: image37.emf]
	Align Left (จัดชิดซ้าย) จัดข้อความให้ชิดซ้าย

	[image: image38.emf]
	Center (กึ่งกลาง) จัดข้อความให้อยู่กลางบรรทัด

	[image: image39.emf]
	Align Right (จัดชิดขวา) จัดข้อความให้ชิดขวา

	[image: image40.emf]
	Justify (ชิดขอบ) จัดข้อความให้เสมอกันทั้งซ้ายและขวา

	[image: image41.emf]
	Distributed (กระจาย) เหมือนชิดขอบ แต่จะเพิ่มช่องไฟระหว่างอักษรและประโยคในภาษไทย เพื่อความสวยงาม

	[image: image42.emf]
	Line Spacing (ระยะบรรทัด) ปรับระยะห่างระหว่างบรรทัด

	[image: image43.emf]
	Numbering (ลำดับเลข) เติมหรือยกเลิกเลขลำดับหน้าข้อความ

	[image: image44.emf]
	Bullets (สัญลักษณ์แสดงหัวข้อย่อย) เติมหรือยกเลิกจุดสีดำ (bullets) หรือสัญลักษณ์อื่น ๆ หน้าข้อความ

	[image: image45.emf]
	Decrease Indent (ลดการเยื้อง) ร่นทั้งย่อหน้าไปทางซ้าย 1 ขั้น

	[image: image46.emf]
	Increase Indent (เพิ่มการเยื้อง) ร่นทั้งย่อหน้าไปทางขวา 1 ขั้น

	[image: image47.emf]
	Outside Boder (เส้นขอบนอก) ตีเส้นหรือลงเส้นที่ขอบด้านต่าง ๆ

	[image: image48.emf]
	Highlight (เน้น) เลือกแถบสีเพื่อเน้นข้อความ (เหมือนปากกาสีสะท้อนแสง)

	[image: image49.emf]
	Font Color (สีแบบอักษร) เลือกสีของตัวอักษร


สำหรับแถบเครื่องมืออื่นๆ ที่ได้กล่าวถึงยังมีอีกมากมาย โดยปกติแล้วถ้าผู้ใช้งานต้องการเพิ่มเติมก็สามารถเพิ่มแถบเครื่องมือในหมวดอื่นได้ 
2. การออกจาก Word

1.  คลิกที่เมนู File -> คลิก Exit  หรือ  กด Alt + F4  หรือ คลิกที่ปุ่ม [image: image50.jpg]


 บน Title bar
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รูปที่ 4 การออกจากโปรแกรม
3. การสร้างงานใหม่ 
1.  คลิกที่เมนู File -> คลิก New

2.  บนแผ่นงาน General คลิก Blank Document


3. จากนั้นสามารถทำการเพิ่มข้อความ สัญลักษณ์ รูปภาพ กราฟ หรือตารางได้ตามต้องการ
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รูปที่ 5 การสร้างเอกสารใหม่
4. การบันทึก และเปิดงานที่มีอยู่
4.1 การบันทึกงานใหม่
1.  คลิกที่เมนู File -> คลิก Save  หรือ  คลิกที่ปุ่ม Save บน Standard toolbar  หรือ กด Ctrl + S จะปรากฏกล่อง Save As Dialog บนหน้าจอ
2.  ในช่อง File Name พิมพ์ชื่อไฟล์ที่ต้องการบันทึก
3.  ถ้าต้องการเปลี่ยน folder หรือ drive ใหม่  ในช่อง Save in คลิกที่ ▼ เพื่อเลือกตำแหน่งใหม่ที่ต้องการ
4.  ถ้าต้องการสร้าง folder ใหม่ ให้คลิกที่ปุ่ม new folder  -> ใส่ชื่อ folder  -> ดับเบิ้ลคลิกที่ folder ใหม่
5.  ในช่อง Save as type คลิกที่ ▼ เพื่อเลือกรูปแบบของเอกสารที่ต้องการให้บันทึกเป็น
6.  คลิกที่ปุ่ม Save เพื่อทำการบันทึก (หรือ คลิกที่ปุ่ม Cancel เพื่อยกเลิกคำสั่ง)
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รูปที่ 6 การบันทึกเอกสาร
4.2 การบันทึกงานขณะกำลังทำงาน
1.  คลิกที่เมนู File -> คลิก Save หรือ คลิกที่ปุ่ม Save บน Standard toolbar  หรือ กด Ctrl + S
4.3 การบันทึกงานในชื่อใหม่
1.  คลิกที่เมนู File -> คลิก Save As จะปรากฏกล่อง Save As Dialog บนหน้าจอ
หมายเหตุ  ขั้นตอนต่อมาดูการบันทึกงานใหม่
4.4 การเปิดงานที่มีอยู่แล้ว
1.  คลิกที่เมนู File -> คลิก Open หรือ คลิกที่ปุ่ม Open บน Standard toolbar หรือ กด Ctrl + O จะปรากฏกล่อง Open บนหน้าจอ
2.  เปลี่ยน folder หรือ drive ใหม่  ในช่อง Look in คลิกที่ ▼ เพื่อไปที่ไฟล์อยู่
3.  ดับเบิ้ลคลิกที่ไฟล์ที่ต้องการ  หรือ  คลิกที่ไฟล์ที่ต้องการ -> คลิกที่ปุ่ม Open
5. การพิมพ์และแก้ไขข้อความ
5.1 การย้ายตำแหน่ง cursor

	การย้าย ….
	วิธีการ

	ไปทางซ้าย (หรือขวา) 1 อักขระ
	กด ← (หรือ →)

	ไปทางซ้าย (หรือขวา) 1 คำ
	กด Ctrl + ←  (หรือ Ctrl + →)

	ขึ้น (หรือลง) 1 บรรทัด
	กด ↑ (หรือ ↓)

	ขึ้น (หรือลง) 1 ย่อหน้า
	กด Ctrl +↑ (หรือ Ctrl +↓)

	ไปที่จุดเริ่มต้น (หรือท้าย) ของบรรทัด
	กด Home (หรือ End)

	ขึ้น (หรือลง) 1 หน้าจอ
	กด PgUp (หรือ PgDn)

	ไปที่จุดเริ่มต้น (หรือท้าย) ของหน้าจอ
	กด Ctrl + PgUp (หรือ Ctrl + PgDn)

	ไปที่จุดเริ่มต้น (หรือท้าย) ของเอกสาร
	กด Ctrl + Home (หรือ Ctrl + End)



หมายเหตุ  1.│(Insertion point) หมายถึง ตำแหน่ง cursor ที่รอรับการพิมพ์
2. ใช้ Backspace ในการลบตัวอักขระก่อนหน้า และใช้ Del ในการลบตัวอักขระถัดไป
5.2 การเลื่อนหน้าจอโดยใช้ mouse

	การเลื่อน ….
	วิธีการ

	ขึ้น (หรือลง) 1 บรรทัด
	คลิก ▲ (หรือ ▼) บน vertical scroll bar

	ขึ้น (หรือลง) 1 หน้าจอ
	คลิกที่ช่องว่างระหว่าง ▲ (หรือ ▼) กับ □ บน vertical scroll bar

	ขึ้น (หรือลง) ตามต้องการ
	ลาก □ บน vertical scroll bar ขึ้น (หรือ ลง)

	ขึ้น (หรือลง) 1 หน้าเอกสาร
	คลิกที่เครื่องหมาย Previous Page (หรือ Next Page) บน vertical scroll bar


5.3 การเลือกข้อความโดยใช้ mouse

	การเลือก ….
	วิธีการ

	ตามจำนวนที่ต้องการ
	ใช้ mouse ชี้ไปที่ตำแหน่งเริ่มต้น,  กดปุ่มขวา,  ลากให้เกิดการเน้นบนข้อความที่เลือกแล้วปล่อยนิ้วออกจากปุ่ม

	1 คำ
	ดับเบิ้ลคลิกบนคำที่ต้องการเลือก

	1 ประโยค
	กด Ctrl ค้าง พร้อมทั้งคลิกที่ตำแหน่งใดก็ได้ในประโยค

	1 บรรทัด
	ใช้ mouse ชี้ที่หน้าบรรทัด (cursor จะเปลี่ยนเป็น ⇗ ) แล้วคลิก

	หลายบรรทัด
	ใช้ mouse ชี้ที่หน้าบรรทัด (cursor จะเปลี่ยนเป็น ⇗ ) แล้วลากไปบนบรรทัดที่ต้องการเลือก

	1 ย่อหน้า
	ใช้ mouse ชี้ที่หน้าย่อหน้าที่ต้องการเลือก (cursor จะเปลี่ยนเป็น ⇗ ) แล้วดับเบิ้ลคลิก

	ทั้งเอกสาร
	กด Ctrl ค้าง พร้อมทั้งคลิกที่ตำแหน่งใดก็ได้หน้าเอกสาร


5.4 การเลือกข้อความโดยใช้ ปุ่มกด
	การเลือก ….
	วิธีการ

	ตามจำนวนที่ต้องการ
	เลื่อน Insertion point ไปที่ตำแหน่งเริ่มต้น,  กด Shift ค้างไว้,  กดที่ ← (หรือ →) เพื่อไปยังตำแหน่งท้ายข้อความแล้วปล่อยนิ้วออกจากปุ่ม Shift

	ทั้งเอกสาร
	กด Ctrl + A


5.5 การลบ คัดลอก และปะข้อความ
1. สำหรับการคัดลอกข้อความ  ให้คลิกเมนู Edit -> คลิก Copy  หรือ คลิกที่ปุ่ม Copy บน Standard toolbar หรือ กด Ctrl + C
(สำหรับการย้ายข้อความ  ให้คลิกเมนู Edit -> คลิก Cut  หรือ คลิกที่ปุ่ม Cut บน Standard toolbar หรือ กด Ctrl + X)

2. ย้าย cursor ไปที่ตำแหน่งที่ต้องการคัดลอก (หรือย้าย) ข้อความ
3. คลิกเมนู Edit -> คลิก Paste  หรือ คลิกที่ปุ่ม Paste บน Standard toolbar หรือ กด Ctrl + v
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รูปที่ 7 การคัดลอกข้อความ
6. การค้นหาและแทนที่ข้อความ
6.1 การค้นหาข้อความ
1. คลิกเมนู Edit -> คลิก Find  หรือ กด Ctrl + F  จะปรากฏกล่อง Find and Replace dialog

2. ในช่อง Find What  ใส่ข้อความที่ต้องการค้นหา
3. คลิกปุ่ม Find Next เพื่อทำการค้นหา  Word จะค้นหาและหยุดเมื่อพบข้อความ  โดยจะมีการเน้นคำในข้อความ  ถ้าไม่พบจะหยุดการค้นหา
4. คลิกปุ่ม Find Next เพื่อทำการค้นหาต่อไป  หรือกด Esc เพื่อปิดกล่อง Find and Replace dialog
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รูปที่ 8 การค้นหาข้อความ
6.2 การกำหนดทางเลือกในการค้นหา

คลิกที่ปุ่ม More  จะปรากฏทางเลือกเพิ่มเติมในกล่อง Find and Replace dialog  โดยที่
1. Match case  จะหาข้อความตามอักขระตัวพิมพ์ตรงตามที่กำหนดเท่านั้น
2. Find Whole Words Only  จะหาข้อความทั้งคำตรงตามที่กำหนดเท่านั้น
3. Use Wildcards  สามารถใช้  *  ในการแทนค่าอักขระหรือชุดอักขระใดๆในข้อความที่ค้นหา  และใช้  ?  แทนหนึ่งตัวอักขระใดๆในข้อความที่ค้นหา
4. Sounds Like  จะหาข้อความตามที่กำหนด รวมถึงคำที่พ้องเสียง
5. Find All Word Forms  จะหาข้อความตามที่กำหนด รวมถึงคำดังกล่าวในรูปอื่น เช่น คำในรูปอดีต
6.3 การค้นหาข้อความ
1. คลิกเมนู Edit -> คลิก Replace  หรือ กด Ctrl + H  จะปรากฏกล่อง Find and Replace dialog

2. ในช่อง Find What  ใส่ข้อความที่ต้องการค้นหา
3. ในช่อง Replace With  ใส่ข้อความที่ต้องการเปลี่ยนเป็น
4. คลิกปุ่ม Find Next เพื่อทำการค้นหา  Word จะค้นหาและหยุดเมื่อพบข้อความ  โดยจะมีการเน้นคำในข้อความ  ถ้าไม่พบจะหยุดการค้นหา
5. คลิกที่ปุ่ม Replace เพื่อต้องการเปลี่ยนข้อความที่พบ, คลิกที่ปุ่ม Cancel เมื่อไม่ต้องการเปลี่ยนข้อความที่พบ  หรือ คลิกที่ปุ่ม Replace All เมื่อต้องการเปลี่ยนข้อความทุกที่ในเอกสาร
6. คลิกปุ่ม Find Next เพื่อทำการค้นหาต่อไป  หรือกด Esc เพื่อปิดกล่อง Find and Replace dialog

7. การสั่งพิมพ์งาน
1. คลิกเมนู File -> คลิก Print  หรือ กด Ctrl + P  จะปรากฏกล่อง Print dialog

2. ในช่อง Name คลิกที่ ▼ เพื่อเลือกเครื่องพิมพ์
3. ในกรอป Page range เลือกหน้าเอกสารที่ต้องการพิมพ์  โดยที่
-  คลิก All  ถ้าต้องการพิมพ์ทั้งเอกสาร
-  คลิก Current page  ถ้าต้องการพิมพ์เฉพาะหน้าเอกสารปัจจุบัน (ที่ตำแหน่ง cursor อยู่)

-  คลิก Selection  ถ้าต้องการพิมพ์เฉพาะข้อความที่เลือก (ที่มีการเน้นข้อความ)

-  คลิก Page  ถ้าต้องกำหนดหน้าของการพิมพ์  เช่น 1, 3, 7-9

4. ในช่อง Number of copies คลิกที่ ▲  ( หรือ ▼)  เพื่อกำหนดจำนวนสำเนาที่ต้องการพิมพ์
5. ในช่อง Print คลิกที่ ▼  เพื่อกำหนดขอบเขตของเอกสาร  เช่น ทั้งหมด เฉพาะหน้าคี่ เฉพาะหน้าคู่
6. คลิก OK เพื่อพิมพ์เอกสาร หรือ คลิก Cancel เพื่อยกเลิกการพิมพ์
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รูปที่ 9 การพิมพ์เอกสาร
8.  การจัดแต่งเอกสาร
การจัดแต่งเอกสาร เพื่อเอกสารดูน่าสนใจขึ้น โดยดูให้เหมาะสมกับการใช้งาน เช่น เป็นทางการ หรือไม่เป็นทางการ เป็นต้น
8.1 การเปลี่ยนฟอนต์ และขนาดตัวอักษร
ฟอนต์คือรูปแบบของตัวอักษรต่างๆ ฟอนต์มีหลายแบบด้วยกัน ให้ดูที่ชื่อฟอนต์ ถ้าลงท้ายด้วย New, UPC (มาพร้อม Office) หรือขึ้นต้นด้วย PSL, JS, DB ใช้ได้กับภาษไทยและอังกฤษ ในการเปลี่ยนฟอนต์เราสามารถเปลี่ยนได้โดยการทำแถบทึบบนตัวอักษรที่ต้องการแล้วทำการเลือกที่แถบเครื่องมือในช่องเปลี่ยนฟอนต์และขนาดได้เลย หรือไปที่เมนู Format -> Font แล้วทำการเลือกช่องฟอนต์ และขนาดที่ต้องการ
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รูปที่ 10 การปรับแต่งตัวอักษรจากแถบเครื่องมือ
[image: image58.png]Font

Fort | Chatacter Spacing | Text Effects
Complex scrpts

Fon; Fonk syle: B

] [Requlsr ¥ fis ¥

Latintext:

Font: Font sty e

|Cordia New v [Regular vl 15 v
Altext

Font cobr: Underlne sty
ffects

[ strikethrough [ shadow. [ small caps

] Double strikethrough Coutine Oalcaps

[ sugerscript Cemboss ] tiden

O subseript: Oengrave
Preview

Sample dadn

Thi i3 Ty Fort Thi Fnt il b wd o bt prar snd s





รูปที่ 11 การปรับแต่งตัวอักษรจากเมนู Format
8.2 การกำหนดเส้นขอบ
1. ลากแถบทึบบริเวณตัวอักษรที่ต้องการทำเส้นขอบ
2. คลิกเมนู Format -> คลิก Border and Shading  จะปรากฏกล่อง Border and Shading dialog

3. คลิกที่แผ่นงาน Borders
4. ในส่วน Setting  คลิกเลือกรูปแบบเส้นขอบ
5. ในส่วน Style เลือกรูปแบบลักษณะของเส้นขอบ
6. ในช่อง Color  คลิกเลือกสีของเส้นขอบ
7. ในช่อง Width คลิกเลือกขนาดของเส้นขอบ
8. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
8.3 การกำหนดแสงเงา
1. ลากแถบทึบบริเวณตัวอักษรที่ต้องการทำแสงเงา
2. คลิกเมนู Format -> คลิก Border and Shading  จะปรากฏกล่อง Border and Shading dialog

3. คลิกที่แผ่นงาน Shading
4. ในส่วน Fill  คลิกสีของพื้นเงาที่ต้องการ
5. ในส่วน Pattern: Style เลือกรูปแบบลักษณะของพื้นเงา
6. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
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รูปที่ 12 การกำหนดเส้นขอบและเงา
9.  การจัดย่อหน้าและรูปแบบข้อความในเอกสาร
1. คลิกเมนู Format -> คลิก Paragraph จะปรากฏกล่อง Paragraph dialog

2. คลิกที่แผ่นงาน Indents and Spacing
3. ในส่วน Alignment  คลิกเลือกรูปแบบการจัดข้อความว่าเป็น ชิดด้านซ้าย ไว้กลางหน้าเอกสาร ชิดด้านขวา หรือ จัดขอบชิดซ้ายขวา
4. ในส่วน Indentation ในช่อง left กำหนดระยะห่างจากขอบซ้าย  ในช่อง right กำหนดระยะห่างจากขอบขวา
5. ในส่วน Spacing ในช่อง Before กำหนดช่องไฟบรรทัดก่อนหน้า  ในช่อง After กำหนดช่องไฟบรรทัดที่ตามมา
6. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
หมายเหตุ  
1. เราสามารถเลือก รูปแบบการจัดข้อความว่าเป็น ชิดด้านซ้าย ไว้กลางหน้าเอกสาร ชิดด้านขวา หรือ จัดขอบชิดซ้ายขวาได้จาก Formatting toolbar




2. เราสามารถกำหนดการย่อหน้าเอกสารผ่านไม้บรรทัด  โดยที่

▽  หมายถึง ตำแหน่งย่อหน้าของบรรทัดแรก

△ ทางซ้าย  หมายถึง ตำแหน่งย่อหน้าของบรรทัดอื่นที่ไม่ใช่บรรทัดแรก

△ ทางขวา  หมายถึง ตำแหน่งย่อหน้าจากขอบด้านขวาของข้อความ

□ หมายถึง การปรับเปลี่ยนตำแหน่งย่อหน้าของทุกบรรทัด
10.  การกำหนด TAB

1. คลิกเมนู Format -> คลิก Tabs จะปรากฏกล่อง Tabs dialog

2. ในช่อง Default tab stops เลือกระยะ tab อัตโนมัติ
3. ในส่วน Alignment เลือกรูปแบบของ tab

4. ในส่วน Leader กำหนดตัวอักขระนำหน้า tab

5. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
หมายเหตุ  1. เราสามารถเลือกตำแหน่งของ tab โดยคลิกไม้บรรทัด

2. รูปแบบของ tab


    └    หมายถึง ตำแหน่ง tab ที่มีการจัดข้อความชิดซ้าย

   ┘  หมายถึง ตำแหน่ง tab ที่มีการจัดข้อความชิดขวา

  ⊥  หมายถึง ตำแหน่ง tab ที่มีการจัดข้อความกลาง tab

   ⊥.  หมายถึง ตำแหน่ง tab ที่มีการจัดข้อความซ้ายขวาตามจุดทศนิยม
11.  การจัดรูปหน้าเอกสาร  และการแบ่งหน้า
11.1 การแบ่งหน้า
1. คลิกเมนู Insert -> คลิก Break จะปรากฏกล่อง Break dialog

2. คลิกเลือก Page Break
3. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
11.2 การจัดรูปหน้าเอกสาร
1. คลิกเมนู File -> คลิก Page Setup จะปรากฏกล่อง Page Setup dialog

2. คลิกเลือกแผ่นงาน Margins
3. ในกล่องข้อความ Top, Bottom, Left และ Right ใส่ระยะห่างจากขอบที่ต้องการ
4. ในกล่องข้อความ Gutter พิมพ์ระยะที่ต้องการให้บวกเพิ่มเพื่อการเข้าเล่ม
5. ในส่วน Apply To คลิกที่ ▼ เพื่อเลือก
· Whole Document ให้มีผลกับทั้งเอกสาร
· This Point Forward ให้มีผล ณ ตำแหน่งที่ cursor เป็นต้นไป
· This Section ให้มีผลกับเฉพาะส่วนของเอกสารนี้เท่านั้น
6. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
11.3 การกำหนดขนาดกระดาษและรูปแบบการจัดวางกระดาษ
1. คลิกเมนู File -> คลิก Page Setup จะปรากฏกล่อง Page Setup dialog

2. คลิกเลือกแผ่นงาน Paper Size
3. ในส่วน Paper Size คลิกที่ ▼ เพื่อเลือกขนาดของกระดาษที่ต้องการ
4. ในส่วน Orientation คลิกเลือก Portrait หรือ Landscape เพื่อเลือกรูปแบบการจัดวางกระดาษ
5. ในส่วน Apply To คลิกที่ ▼ เพื่อเลือก
· Whole Document ให้มีผลกับทั้งเอกสาร
· This Point Forward ให้มีผล ณ ตำแหน่งที่ cursor เป็นต้นไป
· This Section ให้มีผลกับเฉพาะส่วนของเอกสารนี้เท่านั้น
6. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
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รูปที่ 13 การกำหนดขนาดเอกสาร

12.  การแก้ไขคำอัตโนมัติ 
1. คลิกเมนู Tools -> คลิก AutoCorrect จะปรากฏกล่อง AutoCorrect dialog

2. คลิกเลือกแผ่นงาน AutoCorrect
3. ในกล่องข้อความ Replace ใส่ข้อความที่ต้องการให้มีการแก้ไขอัตโนมัติ
4. ในกล่องข้อความ With ใส่ข้อความที่ต้องการให้แก้ไขเป็น
5. คลิกที่ปุ่ม Add
6. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
หมายเหตุ  ในกรณีที่มีข้อความดังกล่าวในรายการแก้ไขอัตโนมัติอยู่แล้ว จะปรากฏข้อความให้ยืนยันว่าต้องการเปลี่ยนแปลงข้อความการแก้ไขหรือไม่  ถ้าต้องการให้คลิกที่ปุ่ม Yes ถ้าไม่ต้องการให้คลิกที่ปุ่ม No
13.  การกำหนดหัวกระดาษและท้ายกระดาษ
13.1 การแทรกเลขที่หน้า
1. คลิกเมนู Insert -> คลิก Page Numbers จะปรากฏกล่อง Page Numbers dialog

2. ในส่วน Position คลิกที่ ▼ เพื่อเลือกตำแหน่งที่จะวางเลขที่หน้าจากขอบกระดาษบนล่าง
3. ในส่วน Alignment คลิกที่ ▼ เพื่อเลือกตำแหน่งที่จะวางเลขที่หน้าจากขอบกระดาษซ้ายขวา
4. คลิก Format เพื่อเลือกรูปแบบตัวแสดงเลขที่หน้า
5. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
13.2 การกำหนดหัวกระดาษ และท้ายกระดาษ
1. คลิกเมนู View -> คลิก Header and Footer จะเข้าสู่มุมมองแบบโครงร่างหน้ากระดาษ โดยอยู่ในส่วนของหัวกระดาษ (สามารถคลิกที่ปุ่ม switch บน Header and Footer toolbar เพื่อเปลี่ยนไปทำงานกับท้ายกระดาษ)

2. พิมพ์ข้อความที่ต้องการเพิ่มในหัวกระดาษ/ท้ายกระดาษ  โดยใช้หลักการเช่นเดียวกับการพิมพ์เอกสารทั่วไป (สามารถใช้ Formatting toolbar ได้)

3. คลิกที่ปุ่ม close บน Header and Footer toolbar เพื่อออกจากการกำหนดแล้วกลับไปมุมมองปกติ
หมายเหตุ  ในการกำหนดข้อความของหัวกระดาษ/ท้ายกระดาษ สามารถคลิกปุ่มบน Header and Footer toolbar เพื่อเพิ่มข้อมูล เลขที่หน้ากระดาษ จำนวนหน้ากระดาษ วันที่ และเวลา)
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รูปที่ 14 การกำหนดเลขหน้าเอกสาร

13.3 การกำหนดให้หัวกระดาษ/ท้ายกระดาษแตกต่างกันในแต่ละหน้า
1. คลิกเมนู File -> คลิก Page Setup จะปรากฏกล่อง Page Setup dialog

2. คลิกเลือกแผ่นงาน Layout
3. ในส่วน Headers and Footers คลิกเลือก Different odd and even หรือ Different first page

4. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
14.   การกำหนดเลขบรรทัดหรือหัวบรรทัด
14.1 การกำหนดเลขบรรทัดหรือหัวบรรทัด
1. เลือกข้อความที่ต้องการกำหนดเลขบรรทัดหรือหัวบรรทัด
2. คลิกเมนู Format -> คลิก Bullets and Numbering จะปรากฏกล่อง Bullets and Numbering dialog

3. คลิกเลือกแผ่นงาน Bulleted เพื่อกำหนดหัวบรรทัด (หรือ Numbering เพื่อกำหนดเลขที่บรรทัด)

4. เลือกรูปแบบที่ต้องการ
5. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
14.2 การยกเลิกการกำหนดเลขบรรทัดหรือหัวบรรทัด
1. เลือกข้อความที่ต้องการกำหนดเลขบรรทัดหรือหัวบรรทัด
2. คลิกที่ปุ่ม Bullets หรือปุ่ม Numbering บน Formatting toolbar

15.   การสร้างตาราง
15.1 การเพิ่มตาราง
1. คลิกเมนู Table -> คลิก Insert Table จะปรากฏกล่อง Insert Table dialog

2. ในกล่อง Number of rows ใส่จำนวนแถวในตาราง
3. ในกล่อง Number of columns ใส่จำนวนสดมภ์ในตาราง
4. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
หมายเหตุ  ในการกำหนดจำนวนแถวหรือสดมภ์สามารถคลิกที่ลูกศร ▲ หรือ ▼
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รูปที่ 15 การสร้างตาราง

15.2 การทำงานในตาราง
	การกด …
	เพื่อไปที่ …

	Tab
	เซลล์ถัดไป

	Shift + Tab
	เซลล์ก่อนหน้า

	Alt + Home
	เซลล์แรกในแถวปัจจุบัน

	Alt + PgUp
	เซลล์แรกในสดมภ์ปัจจุบัน

	Alt + End
	เซลล์สุดท้ายในแถวปัจจุบัน

	Alt + PgDn
	เซลล์สุดท้ายในสดมภ์ปัจจุบัน


15.3 การเลือกแถวหรือสดมภ์
1. คลิกที่แถวหรือสดมภ์ที่ต้องการเลือก
2. คลิกเมนู Table -> คลิก Select Row เพื่อเลือกแบบแถว (หรือคลิก Select Column เพื่อเลือกแบบสดมภ์) 
15.4 การลบแถวหรือสดมภ์
1. เลือกแถวหรือสดมภ์ที่ต้องการลบ
2. คลิกเมนู Table -> คลิก Delete Row เพื่อเลือกลบแถว (หรือคลิก Delete Column เพื่อเลือกลบสดมภ์) 
15.5 การเพิ่มแถวหรือสดมภ์
1. เลือกแถวหรือสดมภ์ที่ต้องการแทรกเพิ่มก่อนหน้า
2. คลิกเมนู Table -> คลิก Insert Row เพื่อเลือกแทรกแถว (หรือคลิก Insert Column เพื่อเลือกแทรกสดมภ์) 
16. การนำภาพมาใส่ในเอกสาร
การนำภาพมาใส่ในเอกสารของ Word มีอยู่หลายวิธี ซึ่งแต่ละวิธีมีข้อดีข้อเสียต่างกันออกไปขึ้นอยู่กับวัตถุประสงค์ของการ นำภาพไปใช้งาน
16.1 แทรกภาพด้วยคำสั่ง Insert Picture (แทรก รูปภาพ) 
1) คลิกเมาส์ในตำแหน่งที่ต้องการแทรกรูปภาพ 

2) เลือก Insert (แทรก) Picture (รูปภาพ) From File (จากแฟ้ม) หรือคลิกปุ่ม [image: image63.png]


 Insert Picture  (แทรกรูปภาพ) บนแถบเครื่องมือ Drawing ด้านล่าง 

3) คลิกแล้วเลือกโฟลเดอร์ที่เก็บไฟล์ภาพที่ต้องการ 

4) คลิกเลือกไฟล์ภาพ ถ้าจะแสดงตัวอย่างภาพนั้นให้คลิกปุ่ม View (มุมมอง) Preview (แสดงตัวอย่าง) หรือคลิกปุ่ม View (มุมมอง) Thumbnail (รูปขนาดย่อ) 

5) คลิกปุ่ม Insert (แทรก)
16.2 ใส่รูปคลิปอาร์ต (Clip Art)
คลิปอาร์ตหรือภาพตัดปะ เป็นภาพสำเร็จรูปที่นำมาใช้ได้เลยโดยไม่ต้องเสียเวลาไปวาดหรือทำเอง  โดยจะมีการแยกเป็นหมวดหมู่โดยมีโปรแกรม Clip Organizer เป็นตัวจัดการคลิปอาร์ตเหล่านี้ ทำให้สามารถค้นหารูปที่ต้องการ หรือจัดแยกตามกลุ่มที่ต้องการ วิธีการใส่ภาพคลิปอาร์ตในเอกสาร ทำได้หลายวิธี
วิธีที่ 1 : โดยคำสั่ง Insert Clip Art 
1) เลือกคำสั่ง Insert (แทรก) Picture (รูปภาพ) Clip Art (ภาพตัดปะ) หรือคลิกปุ่ม Insert Clip Art 

2) บนทาสก์เพนของ Clip Art (ภาพตัดปะ) ใส่ข้อความที่เกี่ยวข้องกับรูปภาพที่ต้องการค้นหาลงในช่อง Search for เช่น Computer หรือระบุประเภทของรูปภาพ เช่น *.jpg แล้วคลิกปุ่ม go (ไป) (ถ้าต่ออินเตอร์เน็ตอยู่ จะได้ รูปทั้งในเครื่องและจากเว็บ Office Online ของไมโครซอฟท์ แต่ถ้าไม่ได้ต่ออยู่ก็จะได้แต่รูปที่มีในเครื่องเท่านั้น 
3) ในกรอบผลลัพธ์จะแสดงรูปภาพที่ค้นหาได้ ให้คลิกเลือกรูปภาพที่ต้องการ หรือคลิกเลื่อนสโครล์บาร์ขึ้นลงไปยัง ภาพอื่น ๆ 
วิธีที่ 2 : โดยใช้ Clip Organizer 
Clip Organizer คือโปรแกรมย่อยของชุด Office ที่เก็บภาพสำเร็จรูป, ภาพถ่าย, เสียง, ภาพเคลื่อนไหว ตลอดจนไฟล์ที่เป็นมัลติมีเดียต่าง ๆ
17. การพิมพ์สูตรสมการต่างๆ
ในการพิมพ์สูตรสมการนั้นต้องเพิ่มแถบเครื่องมือ Equation ขึ้นมาก่อนโดยให้ไปศึกษาดูจากหัวข้อการเพิ่มแถบเครื่องมือ ซึ่งแถบเครื่องมือ Equation จะอยู่ในกลุ่ม Insert และรูปไอคอนคือ [image: image64.png]


 ลากมาวางในแถบเครื่องมือ 

การเรียกสูตรสมการ

วิธีที่ 1 

1. คลิกวางเคอร์เซอร์ตรงตำแหน่งที่ต้องการพิมพ์สมการ
2. เลือกที่ปุ่มแถบเครื่องมือ [image: image65.png]



3. เลือกใช้เครื่องมือในชุดสมการต่างๆ ตามต้องการ
วิธีที่ 2 

1. คลิกวางเคอร์เซอร์ตรงตำแหน่งที่ต้องการพิมพ์สมการ
2. ไปที่เมนู Insert -> Object

3. เลือกที่หัวข้อ Microsoft Equation

4. เลือกใช้เครื่องมือในชุดสมการต่างๆ ตามต้องการ
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แถบเครื่องมือที่ใช้พิมพ์สูตรสมการ

รูปที่ 16 รูปการเลือกแถบเครื่องมือสูตรสมการ
ตัวอย่างการพิมพ์สมการ
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แบบฝึกทดลองที่ 1
1. เปิดโปรแกรม Microsoft Word และสร้างเอกสารใหม่
2. พิมพ์ข้อมูลต่อไปนี้ เริ่มต้นที่บรรทัดที่ 1 คอลัมน์ที่ 1 ของเอกสาร ดังตัวอย่างหน้าถัดไป
3. ทำการแก้ไขลักษณะของตัวอักษรตามตัวอย่าง
4. บันทึกไฟล์ชื่อ Example1.doc
การปรับแต่งฟอนต์ในเอกสาร

ฟอนต์ (Font) คือรูปแบบตัวอักษรใน Windows ที่เราสามารถนำมาใช้ได้ การใช้ฟอนต์ที่แตกต่างกันจะทำให้ข้อความในเอกสารดูน่าสนใจ โดยเรามักพบว่าในเอกสารเดียวกันนั้นมีการใช้ฟอนต์หลากหลายรูปแบบเสมอ สำหรับฟอนต์แต่ละตัวจะมีชื่อประจำตัวอยู่เช่น Arial, CordiaUPC, Times New Roman เป็นต้น
การเลือกใช้ฟอนต์ที่ใช้

ฟอนต์ที่เราสามารถเลือกนำมาใช้ได้นั้นมีอยู่มากมาย เพื่อให้เหมาะสมกับชนิดของเอกสารที่เราสร้างขึ้น เช่น หากเป็นเอกสารในเชิงวิชาการมักใช้ฟอนต์ชนิด CordiaUPC หรือ AngsanaUPC เป็นต้น หรือหากเป็นเอกสารที่ต้องการลูกเล่น ดึงดูดให้น่าสนใจ เราก็สามารถเลือกใช้ฟอนต์ชนิดอื่นๆกับเอกสารของเราได้ เป็นต้น
	ลักษณะพิเศษ
	รูปแบบ
	ผลลัพธ์

	Strikethrough
	ขีดเส้นทับ
	Microsoft Word 2003

	Double Strikethrough
	ขีดทับคู่
	Microsoft Word 2003

	Superscript
	ตัวยก
	Microsoft Word 2003

	Subscript
	ตัวห้อย
	Microsoft Word 2003

	Shadow
	เงา
	Microsoft Word 2003

	Outline
	เค้าร่าง
	Microsoft Word 2003

	Emboss
	นูนขึ้น
	Microsoft Word 2003

	Engrave
	รอยจารึก
	Microsoft Word 2003

	Small caps
	ตัวพิพม์ใหญ่ขนาดเล็ก
	Microsoft Word 2003

	All caps
	ตัวพิพม์ใหญ่ทั้งหมด
	Microsoft Word 2003


กำหนดข้อความให้เป็นตัวหนา ตัวเอน ตัวขีดเส้นใต้
นอกจากการตกแต่งเอกสารด้วยฟอนต์ที่แตกต่างกันแล้ว เราสามารถเน้นข้อความในเอกสารที่เราต้องการให้โดดเด่น เช่น ข้อความที่เป็นหัวข้อ ข้อความที่เป็นประโยคสำคัญภายในเอกสาร หรือเป็นคำพูดที่ยกมาจากที่อื่น เป็นต้น โดยกำหนดขนาดตัวอักษร เช่น A A A A A A A หรือกำหนดรูปแบบเพิ่มเติมได้ เช่น ข้อความขีดเส้นใต้ ข้อความตัวหนา ข้อความตัวเอียง เป็นต้น


แบบฝึกทดลองที่ 2
1. เปิดโปรแกรม Microsoft Word และสร้างเอกสารใหม่
2. พิมพ์ข้อมูล ดังตัวอย่างข้างล่าง
3. บันทึกไฟล์ชื่อ Example2.doc


[image: image75.wmf]100

´

=

R

SC

SC

U

U

Z

 

[image: image76.wmf]2

02

2

01

R

R

Z

SC

+

=




[image: image77.wmf]0

2

2

=

+

x

m

k

dt

x

d






[image: image78.wmf]÷

÷

ø

ö

ç

ç

è

æ

+

=

f

t

m

k

A

x

sin



[image: image79.wmf]å

=

ú

û

ù

ê

ë

é

+

+

=

a

p

p

1

0

sin

cos

2

)

(

n

n

n

L

x

n

b

L

x

n

a

a

x

f



[image: image80.wmf],...

3

,

2

,

1

,

0

,

cos

)

(

1

=

=

ò

-

n

dt

L

x

n

t

f

L

a

L

L

n

p



[image: image81.wmf],...

3

,

2

,

1

,

sin

)

(

1

=

=

ò

-

n

dt

L

x

n

t

f

L

b

L

L

n

p


	CEW-01 (ส่วนที่ 2): Microsoft Power Point


วัตถุประสงค์  เรียนรู้การใช้งานพื้นฐานโปรแกรมการเตรียมงานนำเสนอ Microsoft Powerpoint

สามารถปรับแต่ง แก้ไขสื่อนำเสนอ และกำหนดการนำเสนอแบบต่างๆได้
กล่าวนำ

Microsoft Powerpoint เป็นโปรแกรมที่ใช้สำหรับนำเสนองาน ซึ่งสามารถนำภาพ วิดีโอ เสียงต่างๆ ลงไปในงานได้ อีกทั้ง Microsoft Powerpiont ยังมีเครื่องมืออีกมากมายที่ทำให้เราสร้างงานนำเสนอได้อย่างง่ายดาย
การสร้างสื่อนำเสนอด้วย  PowerPoint

1. การเข้าสู่ PowerPoint

วิธีที่ 1 : เปิดเมนู Start -> คลิก Programs -> คลิก Microsoft PowerPoint
วิธีที่ 2 : ดับเบิ้ลคลิกที่ icon ของ Microsoft Powerpoint บน desktop (ถ้ามี)
[image: image82.emf]
รูปที่ 1 การเข้าสู่ Microsoft Powerpoint

เมื่อเรียกโปรแกรมขึ้นมาใช้งานแล้ว จะเข้าสู่หน้าต่างของโปรแกรม Microsoft PowerPoint ดังรูปที่ 2 หน้าต่างโปรแกรมจะมีเมนู และแถบเครื่องมือต่างๆ ส่วนพื้นที่ว่างจะเป็นพื้นที่ที่เตรียมไว้ให้เราจัดการใส่สิ่งที่ต้องการนำเสนอลงไป  
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รูปที่ 2 powerpoint.  กล่อง Introductory dialog

AutoContent wizard : 
นำเข้าสู่ส่วนของโปรแกรมที่ช่วยในการสร้างงานนำเสนออัตโนมัติจากข้อมูลที่ผู้ใช้กำหนด
Template : 
นำเข้าสู่แม่แบบในการสร้างงานนำเสนอ (Presentation Template) และ แม่แบบในการออกแบบงานนำเสนอ (Presentation Design Template)

Blank presentation : 
เป็นการสร้างงานนำเสนอแบบอิสระตามความต้องการของผู้ใช้   โดยเลือกรูปแบบภาพนิ่งจากกล่อง New Slide dialog

Open an existing presentation :
เป็นการเปิดงานนำเสนอที่มีอยู่แล้วเพื่อปรับปรุง หรือนำเสนอ

หน้าต่างของโปรแกรมจะประกอบไปด้วย เมนูและแถบเครื่องมือต่างๆ เพื่ออำนวยความสะดวกในการใช้งาน
2. การออกจาก PowerPoint

1.  คลิกที่เมนู File -> คลิก Exit  หรือ  กด Alt + F4  หรือ  คลิกที่ปุ่ม [image: image84.png]


 บน Title bar

3. การสร้างงานใหม่
1.  คลิกที่เมนู File -> คลิก New
2. บนแผ่นงาน General คลิก Blank Presentation จะปรากฏกล่อง New Slide dialog บนจอ
หรือ บนแผ่นงาน Presentation คลิก AutoContent wizard เพื่อเข้าสู่ AutoContent wizard

หรือ บนแผ่นงาน Presentation คลิกเลือกแม่แบบในการสร้างงานนำเสนอ
4. หน้าจอการทำงานของ PowerPoint
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รูปที่ 3 powerpoint.3  แสดงหน้าจอการทำงานของ PowerPoint
	Screen elements
	ความหมายและหน้าที่

	Presentation window
	พื้นที่แสดงโครงข้อความของงานนำเสนอ

	Standard toolbar
	รูปภาพหรือปุ่มที่ทำให้สะดวกต่อการใช้งานนำเสนอ

	Formatting toolbar
	รูปภาพหรือปุ่มที่ทำให้สะดวกต่อการจัดรูปแบบของงานนำเสนอ

	Status bar
	แสดงข้อมูลของเอกสารที่กำลังทำงาน

	View buttons
	รูปภาพหรือปุ่มที่ทำให้สะดวกต่อการเปลี่ยนมุมมองของงานนำเสนอ

	Drawing toolbar
	รูปภาพหรือปุ่มที่ทำให้สะดวกต่อการวาดภาพ


เราสามารถทำงานต่อไปนี้ได้ในขณะที่เรียกใช้งานนำเสนอในมุมมองนำเสนอภาพนิ่ง:
	หยุดหรือเริ่มต้นงานนำเสนอใหม่อีกครั้งได้ด้วยการ
	กด S หรือ PLUS SIGN (เครื่องหมายบวก)

	สิ้นสุดการนำเสนอภาพนิ่ง
	กด ESC, CTRL+BREAK, หรือ HYPHEN (เครื่องหมายขีดสั้น)

	ไปที่ หมายเลข ภาพนิ่ง
	กด หมายเลข+ENTER

	ไปที่ภาพนิ่งที่ถูกซ่อนไว้ภาพต่อไป
	กด H

	ย้อนกลับไปที่ภาพนิ่งภาพแรก
	กด 1+ENTER (หรือกดปุ่มบนเมาส์ทั้งสองปุ่มติดต่อกัน 2 วินาที)

	แสดงผลหน้าจอที่เป็นสีดำ หรือย้อนกลับไปที่การนำเสนอภาพนิ่ง
	กด B หรือ PERIOD (เครื่องหมายจุด)

	แสดงผลหน้าจอสีขาว หรือย้อนกลับไปที่การนำเสนอภาพนิ่ง
	กด W หรือ COMMA  (เครื่องหมายจุลภาค)

	ตั้งเวลาใหม่ในขณะที่กำลังซ้อมการนำเสนอ
	กด T

	แสดงหรือซ่อนการมาร์กอัปด้วยน้ำหมึก
	กด CTRL+M


Blank Presentation
เป็นรูปแบบ Presentation ที่เราจะต้องสร้างด้วยตัวเองทุกขั้นตอน ได้อย่างอิสระซึ่งเราสามารถสร้างได้ดังนี้
1. คลิกที่เมนู File -> New 

2. เลื่อนเมาส์ไปทางพื้นที่ New Presentation ด้านขวามือ คลิกที่ Blank Presentation ตามรูปด้านล่างนี้

                  [image: image86.emf]
รูปที่ 4 การสร้าง Blank Presentation 

From Design Template

เป็นวิธีการสร้าง Presentation อีกวิธีหนึ่ง ซึ่งจะคล้ายกับ AutoContent Wizard แต่ต่างกันตรงที่ไม่มีการแนะนำเกี่ยวกับเนื้อหาให้ สำหรับถ้าต้องการสร้างสไลด์พร้อมเลือกรูปแบบของพื้นสไลด์ไปด้วย ซึ่งรูปแบบพื้นสไลด์ที่โปรแกรมจะมีให้เลือกหลายรูปแบบด้วยกัน มีวิธีการดังนี้
1. คลิกที่เมนู File -> New 

2. เลื่อนเมาส์ไปทางพื้นที่ New Presentation ด้านขวามือ คลิกที่ From design template ตามรูปด้านล่างนี้
3. คลิกเลือกจากรูปแบบในรายการเพื่อใช้งาน

                   [image: image87.emf]
รูปที่ 5 การออกแบบ Presentation จาก Template

From AutoContents Wizard

เป็นการสร้าง Presentation ภายใต้การแนะนำขั้นตอนการทำงาน และการลำดับเนื้อหา จะมีการกำหนดรายละเอียดของสไลด์ ทำการตกแต่งสไลด์ให้เรียบร้อย สวยงาม เหมาะสำหรับงานที่ต้องการใช้เวลาน้อย เพราะจะช่วยลดเวลาในการไปกำหนดรูปแบบตัวหนังสือ ขนาด สี และพื้นของสไลด์ และเหมาะสำหรับผู้ไม่คุ้นเคยกับ Powerpoint มาก่อน ซึ่งการจะสร้างงานแบบนี้สามารถทำได้ดังนี้
1. คลิกที่เมนู File -> New 

2. เลื่อนเมาส์ไปทางพื้นที่ New Presentation ด้านขวามือ คลิกที่ From AutoContents Wizard ตามรูปด้านล่างนี้
3. คลิก Next เลือกรูปแบบในรายการเพื่อใช้งาน แล้วกด Finish
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รูปที่ 6 การสร้างสื่อนำเสนอโดย Autocontent Wizard
From Existing Presentation 

เป็นการเปิดสไลด์ที่มีอยู่เดิม นำมาสร้างเป็นไฟล์สไลด์ใหม่ มีวิธีการดังนี้
1. คลิกที่เมนู File -> New 

2. เลื่อนเมาส์ไปทางพื้นที่ New Presentation ด้านขวามือ คลิกที่ From Exesting Presentation ตามรูปด้านล่างนี้
3. คลิก Next เลือกรูปแบบในรายการเพื่อใช้งาน แล้วกด Finish
          [image: image90.emf]
[image: image91.emf]
รูปที่ 7 การสร้างสื่อนำเสนอโดย From Exesting Presentation

5. การบันทึก การเปิดงานที่มีอยู่ และการปิดงาน
5.1 การบันทึกงานใหม่
1.  คลิกที่เมนู File -> คลิก Save หรือ  คลิกที่ปุ่ม Save บน Standard toolbar  หรือ กด Ctrl + S จะปรากฏกล่อง Save As Dialog บนหน้าจอ
2.  ในช่อง File Name พิมพ์ชื่อไฟล์ที่ต้องการบันทึก
3.  ถ้าต้องการเปลี่ยน folder หรือ drive ใหม่  ในช่อง Save in คลิกที่ ▼ เพื่อเลือกตำแหน่งใหม่ที่ต้องการ
4.  ถ้าต้องการสร้าง folder ใหม่ ให้คลิกที่ปุ่ม new folder  -> ใส่ชื่อ folder  -> ดับเบิ้ลคลิกที่ folder ใหม่
5.  ในช่อง Save as type คลิกที่ ▼ เพื่อเลือกรูปแบบของเอกสารที่ต้องการให้บันทึกเป็น
6.  คลิกที่ปุ่ม Save เพื่อทำการบันทึก (หรือ คลิกที่ปุ่ม Cancel เพื่อยกเลิกคำสั่ง)

5.2 การบันทึกงานขณะกำลังทำงาน
1.  คลิกที่เมนู File -> คลิก Save หรือ  คลิกที่ปุ่ม Save บน Standard toolbar  หรือ กด Ctrl + S
5.3 การบันทึกงานในชื่อใหม่
1.  คลิกที่เมนู File -> คลิก Save As จะปรากฏกล่อง Save As Dialog บนหน้าจอ
หมายเหตุ  ขั้นตอนต่อมาดูการบันทึกงานใหม่
5.4 การเปิดงานที่มีอยู่
1. คลิกที่เมนู File -> คลิก Open หรือ คลิกที่ปุ่ม Open บน Standard toolbar หรือ กด Ctrl +O จะปรากฏกล่อง Open บนหน้าจอ
2. เปลี่ยน folder หรือ drive ใหม่  ในช่อง Look in คลิกที่ ▼ เพื่อไปที่ไฟล์อยู่
3. ดับเบิ้ลคลิกที่ไฟล์ที่ต้องการ  หรือ  คลิกที่ไฟล์ที่ต้องการ -> คลิกที่ปุ่ม Open
5.5 การปิดงาน
1. คลิกที่เมนู File -> คลิก Close  หรือ  คลิกที่ปุ่ม  [image: image92.png]


 บนมุมขวาบนของหน้าต่างงานนำเสนอ
6. การทำงานกับภาพนิ่งภายใต้มุมมองต่างๆ
6.1 การเปลี่ยนมุมมอง
1.  คลิกที่เมนู View -> คลิกมุมมองที่ต้องการ (Normal, Slide Sorter, Slide Show, Notes Pages)  หรือ  คลิกที่ปุ่มบน view buttons
	[image: image93.png]




(Normal View)   (Slide Sorter View)   (Slide Show)



รูปที่ 8 แถบมุมมองต่างๆ


	[image: image94.emf]

 รูปที่ 9 การเลือกมุมมองจากเมนู



Normal View 

โดยปกติ เมื่อทำการสร้าง และกำหนดรูปแบบสไลด์แล้ว โปรแกมจะอยู่ในมุมมองปกติ ซึ่งโปรแกรมจะแสดงหน้าต่างเป็น 3 ส่วนคือด้านซ้ายจะแสดงเป็นแบบ Outline View และ Slide View ด้านล่างเป็น Note View หากต้องการเลื่อนไปยังสไลด์ต่างๆ ที่สร้างขึ้น สามารถคลิกที่แถบ Slide ด้านซ้ายมือดังรูป
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รูปที่ 10  แสดงหน้าต่างแบบปกติ

Slide Sorter View


ในมุมมองนี้จะแสดงสไลด์ที่ได้สร้างไว้ทั้งหมด คุณสามารถเพิ่มเทคนิคการนำเสนอบนแผ่นสไลด์ การลบสไลด์ หรือการเคลื่อนย้ายสไลด์ ในมุมมองนี้ ตัวอย่างการแสดงแบบ Slide Sort View
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รูปที่ 11 การแสดงแบบ Slide Sort View
Note page View

คือมุมมองที่แสดงทั้งหัวข้อ และรูปภาพเพื่อสร้างเอกสารประกอบคำอธิบายสำหรับนำเสนอ (Note Page หรือ Speaker’s Note) เป็นส่วนของเนื้อเรื่อง
· การปรับพื้นที่ในส่วนของคำบรรยาย คลิกที่เมนู Format เลือกคำสั่ง Note Background

· หรือคลิกที่เมนู Format เลือกคำสั่ง Note layout จะปรากฏหน้าต่างโปรแกรมดังรูปข้างล่างนี้
             [image: image97.emf]           [image: image98.emf]  
[image: image99.emf]
รูปที่ 12 การแสดงแบบ Note Page View
6.2 การเปลี่ยนไปยังภาพนิ่งต่างๆ เพื่อทำงาน
	มุมมอง
	วิธีการ

	Normal
	เลื่อนไปยังบริเวณภาพนิ่งที่ต้องการโดยใช้ vertical scroll bar แล้วคลิกที่รูปภาพภาพนิ่ง(ทางด้านซ้าย) ของภาพนิ่งที่ต้องการ

	Slide Sorter
	คลิกที่ภาพนิ่งที่ต้องการ

	Slide Show
	ดูรายละเอียดในหัวข้อ 14

	Notes Pages
	คลิกที่ปุ่ม Previous Slide บน vertical scroll bar (หรือกดปุ่ม PgUp) เพื่อไปที่ภาพนิ่งก่อนหน้า และ คลิกที่ปุ่ม Next Slide บน vertical scroll bar (หรือกดปุ่ม PgDn) เพื่อไปที่ภาพนิ่งถัดไป


7. การสั่งพิมพ์งานนำเสนอ
1. คลิกเมนู File -> คลิก Print  หรือ กด Ctrl + P  จะปรากฏกล่อง Print dialog

2. ในช่อง Name คลิกที่ ▼ เพื่อเลือกเครื่องพิมพ์
3. ในกรอป Page range เลือกหน้าภาพนิ่งที่ต้องการพิมพ์  โดยที่
· คลิก All  ถ้าต้องการพิมพ์ทุกภาพนิ่งในงานนำเสนอ
· คลิก Current slide  ถ้าต้องการพิมพ์เฉพาะภาพนิ่งปัจจุบัน 
· คลิก Selection  ถ้าต้องการพิมพ์เฉพาะข้อความที่เลือก (ที่มีการเน้นข้อความ)

· คลิก Slides  ถ้าต้องกำหนดภาพนิ่งในการพิมพ์  เช่น 1, 3, 7-9

4. ในช่อง Number of copies คลิกที่ ▼  ( หรือ ▼)  เพื่อกำหนดจำนวนสำเนาที่ต้องการพิมพ์
5. ในช่อง Print what คลิกที่ ▼  เพื่อเลือกรูปแบบการพิมพ์ของภาพนิ่ง
· เลือก Slides  ถ้าต้องการพิมพ์แต่ละภาพนิ่งใน 1 หน้ากระดาษ
· เลือก Handouts (2 slides per page)  ถ้าต้องการพิมพ์ 2 ภาพนิ่งใน 1 หน้ากระดาษ
· เลือก Handouts (3 slides per page)  ถ้าต้องการพิมพ์ 3 ภาพนิ่งพร้อมที่ว่างเพื่อจดบันทึกใน 1 หน้ากระดาษ
· เลือก Handouts (6 slides per page)  ถ้าต้องการพิมพ์ 6 ภาพนิ่งใน 1 หน้ากระดาษ
· เลือก Notes Pages  ถ้าต้องการพิมพ์ในรูปภาพนิ่งพร้อมโน๊ตข้อความ
· เลือก Outline view  ถ้าต้องการพิมพ์เฉพาะโครงร่างของภาพนิ่งเพื่อการตรวจสอบ
6. คลิก OK เพื่อพิมพ์เอกสาร หรือ คลิก Cancel เพื่อยกเลิกการพิมพ์
8. การกำหนดหน้ากระดาษการพิมพ์
1. คลิกเมนู File -> คลิก Page Setup  จะปรากฏกล่อง Page Setup dialog

2. ในช่อง Slide sized for คลิกที่ ▼ เพื่อเลือกขนาดของกระดาษพิมพ์
3. ในช่อง Number slide from คลิกที่ ▼  ( หรือ ▼)  เพื่อกำหนดเลขที่หน้าเริ่มต้นของภาพนิ่ง
4. ในส่วน Slides คลิกเพื่อกำหนดรูปแบบการจัดวางกระดาษ
5. ในส่วน Notes, handouts & outline คลิกเพื่อกำหนดรูปแบบการจัดวางกระดาษ
6. คลิก OK เพื่อเลือกกระทำในสิ่งที่กำหนด หรือ คลิก Cancel เพื่อยกเลิกการเลือก
9. การแทรก การลบ และการคัดลอกภาพนิ่ง
9.1 การแทรกภาพนิ่ง
1. เลือกภาพนิ่งที่ต้องการแทรกต่อท้ายด้วยภาพนิ่งใหม่
2. คลิกเมนู Insert -> คลิก New Slide  หรือ กด Ctrl + M  จะปรากฏกล่อง New Slide dialog

3. คลิกรูปแบบภาพนิ่งที่ต้องการแทรก แล้วกดปุ่ม OK  หรือ ดับเบิ้ลคลิกรูปแบบภาพนิ่งที่ต้องการแทรก
9.2 การแทรกภาพนิ่งจากงานนำเสนอที่มีอยู่แล้ว
1. เลือกภาพนิ่งที่ต้องการแทรกต่อท้ายด้วยภาพนิ่งใหม่
2. คลิกเมนู Insert -> คลิก Slides from files จะปรากฏกล่อง  Slide Finder dialog

3. คลิกที่ปุ่ม Browse จะปรากฏกล่อง Insert Slides from Files dialog

4. เลือกงานนำเสนอที่ต้องการคัดลอกภาพนิ่ง (อาจมีการเปลี่ยน folder)  แล้วคลิก Open
5. คลิกที่ปุ่ม Display จะปรากฏภาพนิ่งในกรอปหน้าต่างของกล่อง Slide Finder dialog

6. คลิกเลือกภาพนิ่งที่ต้องการแทรก (ใช้ Horizontal scroll bar เพื่อเลื่อนไปยังภาพนิ่งต่างๆ) แล้วคลิก Insert  หรือ คลิก Insert All ในกรณีที่ต้องการแทรกภาพนิ่งทุกภาพ
7. คลิก Close เมื่อเสร็จสิ้นการทำงาน
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รูปที่ 13  การเพิ่มสไลด์จากไฟล์

9.3 การเลือกภาพนิ่ง
	การเลือกภาพนิ่ง…
	วิธีการ

	หนึ่งภาพ
	คลิกที่ภาพนิ่งที่ต้องการเลือก

	หลายภาพต่อเนื่อง
	คลิกที่ภาพนิ่งภาพแรก ->กดปุ่ม Shift ค้างไว้ -> แล้วคลิกที่ภาพสุดท้ายที่ต้องการเลือก

	หลายภาพไม่ต่อเนื่อง
	คลิกที่ภาพนิ่งภาพแรก ->กดปุ่ม Ctrl ค้างไว้ -> แล้วคลิกที่อื่นๆ ที่ต้องการเลือก


9.4 การลบภาพนิ่ง
1. เลือกภาพนิ่งที่ต้องการลบ
2. คลิกเมนู Edit -> คลิก Delete Slide 

9.5 การตัด(เพื่อย้ายตำแหน่ง) การคัดลอก และการปะภาพนิ่ง
1. เปลี่ยนมุมมองเป็น Slide Sorter

2. เลือกภาพนิ่งที่ต้องการย้ายตำแหน่ง (หรือต้องการคัดลอก)

3. คลิกเมนู Edit -> คลิก Cut ในกรณีที่ต้องการย้ายตำแหน่ง (หรือคลิก Copy ในกรณีที่ต้องการคัดลอก)
4. คลิกที่ภาพนิ่งที่ต้องการปะภาพนิ่งที่ตัด (หรือ คัดลอก) ต่อท้าย
5. คลิกเมนู Edit -> คลิก Paste
หมายเหตุ  สามารถกดปุ่ม Cut, Copy และ Paste บน Standard toolbar หรือ กดปุ่ม Ctrl + X, Ctrl + C และ Ctrl + V  เพื่อตัด คัดลอก และปะภาพนิ่งตามลำดับ
9.6 การย้ายตำแหน่งภาพนิ่งภายใต้มุมมองแบบโครงร่าง
1. คลิกที่หน้าข้อความที่ต้องการย้ายหรือปรับปรุงตำแหน่ง 

2. คลิกที่ปุ่มบน Outlining toolbar  โดยที่
	ปุ่ม
	เพื่อ…

	⇦
	เลื่อนระดับความสำคัญของข้อความขึ้น เช่น จากหัวข้อใหญ่เป็นภาพนิ่ง

	⇨
	ลดระดับความสำคัญของข้อความลง เช่น จากหัวข้อใหญ่เป็นหัวข้อย่อย

	⇧
	เลื่อนข้อความไปไว้ก่อนข้อความก่อนหน้า

	⇩
	เลื่อนข้อความไปไว้หลังข้อความที่ตามมา


9.7 การซ่อนภาพนิ่ง
1. เลือกภาพนิ่งที่ต้องการซ่อน
2. คลิกเมนู Slide Show -> คลิก Hide Slide (คลิก Unhide Slide ในกรณีที่ไม่ต้องการซ่อน) หรือ คลิกที่ปุ่ม Hide/Unhide บน Slide sorter toolbar (เฉพาะในมุมมอง Slide Sorter)
10. การเพิ่มกล่องข้อความในงานนำเสนอ
1. คลิกเมนู Insert -> คลิก Text Box  cursor บนภาพนิ่งในงานนำเสนอจะเปลี่ยนเป็น  ┼
2. คลิกตำแแหน่งบนภาพนิ่งที่ต้องการให้เป็นมุมบนซ้ายของกล่องข้อความค้างไว้  แล้วลากไปยังตำแหน่งที่ต้องการให้เป็นมุมล่างขวาของกล่องข้อความ  แล้วปล่อยมือจากปุ่ม
3. คลิกในบริเวณกล่องข้อความเพื่อพิมพ์ข้อความ
4. คลิกบริเวณอื่นเพื่อหยุดการทำงานกับกล่องข้อความ
หมายเหตุ  ถ้าต้องการแก้ไขวัตถุ ให้ดับเบิ้ลคลิกที่วัตถุที่ต้องการแก้ไข
11. การเพิ่มรูปภาพ ภาพวาด ภาพยนตร์ หรือข้อมูลเสียง ในงานนำเสนอ
11.1 วิธีเปิด Clip Art Gallery

1. คลิกปุ่ม Clip Art บน Standard toolbar

หรือ คลิกเมนู Insert -> คลิก Picture -> คลิก Clip Art
หรือ คลิกเมนู Insert -> คลิก Movies and Sounds -> คลิก Sound from Gallery
หรือ คลิกเมนู Insert -> คลิก Movies and Sounds -> คลิก Movie from Gallery
11.2 วิธีแทรกจากไฟล์ที่มีอยู่
1. คลิกเมนู Insert -> คลิก Picture -> คลิก From File
หรือ คลิกเมนู Insert -> คลิก Movies and Sounds -> คลิก Sound from File
หรือ คลิกเมนู Insert -> คลิก Movies and Sounds -> คลิก Movie from File
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รูปที่ 14  การเพิ่มรูปจาก clipart

12. การเพิ่มกราฟในงานนำเสนอ
1. คลิกเมนู Insert -> คลิก Chart  หรือ คลิกที่ปุ่ม Insert Chart บน Standard toolbar  จะปรากฏหน้าต่าง Microsoft Graph และ Datasheet บนจอ
2. ปรับปรุงค่าใน Datasheet

3. คลิกเมนู Chart -> คลิก Chart Type -> เลือกรูปแบบกราฟที่ต้องการ
4. คลิกเมนู Chart -> คลิก Chart Option -> ปรับปรุงข้อมูลการนำเสนอกราฟ
5. คลิกนอกบริเวณกราฟเพื่อกลับสู่ PowerPoint

13. การเพิ่มผังงานในงานนำเสนอ
1. คลิกเมนู Insert -> คลิก Picture -> คลิก Organization Chart  จะปรากฏหน้าต่าง Microsoft Organization Chart บนจอ
2. พิมพ์ค่าในกล่องข้อความ พร้อมทั้งปรับปรุงผังงานโดยคลิกที่ปุ่ม Subordinate, Co-worker, Manager และ Assistant บน Organization chart toolbar

3. คลิกเมนู File-> คลิก Exit and Return to … เพื่อกลับสู่ PowerPoint
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รูปที่ 15  การเพิ่มรูปผังงาน
14. การปรับปรุงภาพลักษณ์งานนำเสนอ
1. คลิกเมนู Format -> คลิก Apply Design  หรือ คลิกที่ปุ่ม Apply Design บน Standard toolbar  จะปรากฏกล่อง Apply Design บนจอ
2. คลิกแม่แบบการออกแบบที่ต้องการ
3. คลิกปุ่ม Apply เพื่อเลือกใช้ หรือ คลิกปุ่ม Cancel เพื่อยกเลิก
15. การนำเสนองาน
1. เปลี่ยนมุมมองเป็น Slide Show

2. นำเสนองานโดย
	ไปที่…
	วิธีการ

	ภาพนิ่งถัดไป
	คลิกเมาส์ปุ่มซ้าย หรือ กดปุ่ม PgDn หรือปุ่ม  → หรือปุ่ม ↓

	ภาพนิ่งก่อนหน้า
	กดปุ่ม PgUp หรือปุ่ม  ← หรือปุ่ม ↑

	ภาพนิ่งภาพแรก
	กดปุ่ม Home

	ภาพนิ่งภาพสุดท้าย
	กดปุ่ม End



หมายเหตุ  อาจใช้การกดเมาส์ปุ่มขวาในการเปลี่ยนภาพนิ่ง
3. กดปุ่ม Esc เพื่อกลับไปยังมุมมอง Slide

16. การจัดรูปแบบการเปลี่ยนภาพนิ่ง
1. เปลี่ยนมุมมองเป็น Slide Sorter

2. เลือกภาพนิ่งที่ต้องการปรับปรุงรูปแบบการเปลี่ยนภาพ (กด Ctrl + A ในกรณีที่ต้องการเลือกทุกภาพนิ่ง)

3. คลิกเมนู Slide Show -> คลิก Slide Transition  หรือ คลิกที่ปุ่ม Slide Transition บน Standard toolbar  จะปรากฏ Slide Transition บนจอ
4. เลือกรูปแบบและเงื่อนไขการเปลี่ยนภาพนิ่ง
5. คลิกปุ่ม Apply เพื่อให้มีผลต่อภาพนิ่งที่เลือก หรือ คลิก Apply All เพื่อให้มีผลต่อทุกภาพนิ่ง หรือ คลิกปุ่ม Cancel เพื่อยกเลิก
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รูปที่ 16 การกำหนดการเปลี่ยนภาพนิ่ง
17. การใส่วันที่ และหัวท้ายแผ่นสไลด์

การใส่วันที่ (Date/Time), Slide number, Header/Footer


* คลิกเมาส์ที่เมนู Insert


* เลือกคำสั่ง Slide Nunber เมื่อต้องการใส่เลขที่ให้กับแผ่นสไลด์
* เลือกคำสั่ง Date and Time เมื่อต้องการใส่วันที่ และเวลาให้กับแผ่นสไลด์
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รูปที่ 17 หน้าต่างหัวและท้าย
อธิบายเพิ่มเติม

การเลือก Date and time หมายถึง ต้องการใส่วันที่ โดยสามารถเลือกรูปแบบการใส่วันที่ได้หรือถ้าเลือก Update automatically หมายถึง ถ้าวันที่เปลี่ยนแปลงไปก็ให้โปรแกรมปรับเปลี่ยนวันที่ให้ตามอัตโนมัติ นอกจากนั้นยังสามารถกำหนด Slide number, Header และ Footer ในหน้าต่างโปรแกรมเดียวกัน เมื่อทำการกำหนดรายละเอียดตามที่ต้องการเสร็จเรียบร้อยแล้ว ขั้นตอนต่อไปให้ทำดังนี้

1. คลิกเมาส์ที่ปุ่ม Apply เมื่อต้องการทำเพียงแผ่นสไลด์ทั้งหมด

2. คลิกปุ่ม Apply to all เมื่อต้องการทำแผ่นสไลด์ทั้งหมด
18. การใช้สีกับแผ่นสไลด์

ส่วนต่างๆ ของสไลด์ไม่ว่าจะเป็น Clipartม ภาพ, shape ถือว่าเป็น Object หนึ่ง ดังนั้น เราจึงสามารถเปลี่ยนหรือแก้ไขสีของส่วนต่างๆ ได้ดังนี้

1. คลิกเมาส์ที่เมนู Format


2. คลิกเลือกคำสั่ง Background จะปรากฏดังนี้
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รูปที่ 18 การกำหนดการใช้สี
19. การทำสไลด์ต้นแบบ

สไลด์ต้นแบบ (Master) เป็นส่วนที่ใช้ในการกำหนดรูปแบบของแต่ละส่วนในชิ้นงาน เพื่อใช้เป็นมาตรฐาน
ที่ต้องการให้ไปปรากฏในทุกๆ สไลด์  ไม่ว่าจะเป็นอักษร หรือรูปภาพ โดยสามารถเลือกประเภทต้นแบบที่ต้องการ ได้ดังนี้

คลิกที่เมนู View เลือก Master


เลือก Slide Master หรือเลือก Handout Master


หรือเลือก Note Master
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รูปที่ 19 การทำสไลด์ต้นแบบ


เราสามารถเปลี่ยนรูปแบบต่างๆ ในสไลด์ได้เหมือนกับการเปลี่ยนรูปแบบสไลด์ปกติ
20. การนำเสนอสไลด์โดยกำหนดตัวเลือก

Setup Show
เป็นการกำหนดแผ่นสไลด์ที่ต้องการนำเสนอ เช่นต้องการนำเสนอใบที่ 1-5 เป็นต้น

วิธีการทำได้ดังนี้
1. คลิกเลือกเมนู Slide Show

2. คลิกเลือก Setup Show จะมี Dialog Box ดังรูป
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รูปที่ 20 การกำหนดตัวเลือกการนำเสนอ
Shot type 
คือ เลือกวิธีการนำเสนอในรูปแบบต่างๆ
Show Option
คือ การกำหนดเงื่อนไขให้กับแผ่นสไลด์หรือไฟล์สไลด์
Show Slide
คือ การเลือกแผ่นสไลด์ที่ต้องการนำเสนอ เช่น สไลด์แผ่นที่ 1-5

Advance slides
คือ การนำเสนอสไลด์แบบ Mannual หมายถึง การเคาะ Enter, Click mouse, เคาะ Space 

Bar, กดปุ่ม PageUp/Down, ลูกศรลง หรือขวา สำหรับ Using Timings หมายถึง ตั้งเวลา
อัตโนมัติให้กับแผ่นสไลด์
Custom Show
เป็นการกำหนดแผ่นสไลด์ที่ต้องการนำเสนอ เช่นต้องการนำเสนอสไลด์ใบที่ 1,3,5,8 เป็นต้น
1. คลิกที่เมนู Slide Show

2. Custom Show จะมี Dialog Box ดังรูป 

3. คลิกที่ปุ่ม New จะปรากฏ Dialog Box

4. เลือกสไลด์ที่ต้องการโดยกด Add จากนั้นก็กด OK ออกมาได้เลย
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รูปที่ 21 การเลือกการนำเสนอแบบ Custom

21. การกำหนดการเคลื่อนไหวของภาพ หรืออักษร

1. คลิกขวาที่ภาพ หรืออักษรที่ต้องการ แล้วเลือก Custom Animation…


2. คลิกที่ปุ่ม Add Effect และเลือกรายการตามต้องการ

3. กดปุ่ม Slide Show เพื่อทดสอบ
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รูปที่ 22 การกำหนดการเคลื่อนไหว
แบบฝึกทดลอง
1. สร้างไฟล์นำเสนอที่มีความน่าสนใจไว้ในชื่อไฟล์ exam1.ppt ดังต่อไปนี้
1.1  ภาพนิ่งที่ 1 ประกอบด้วยชื่องานนำเสนอ ชื่อ และรหัสนักศึกษาของสมาชิกในกลุ่ม และ วันที่จัดทำงานนำเสนอ
1.2  ในงานนำเสนอจะต้องมีภาพนิ่งที่ประกอบด้วยข้อความ รูปภาพ กราฟ ผังงาน และวัตถุอื่นตามที่เห็นสมควร
1.3  นักศึกษามีอิสระในการคิดหัวข้องานนำเสนอ โดยในงานนำเสนอจะต้องประกอบด้วยจำนวน Slide อย่างน้อย 5 Slide
1.4  ปรับปรุงภาพลักษณ์งานนำเสนอ พร้อมทั้งกำหนดรูปแบบการเปลี่ยนภาพนิ่งตามความเหมาะสม
1.5  กำหนดรูปแบบการเคลื่อนไหวให้เหมาะสมตามลำดับ
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